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Quick Installation & Setup 
OCP 5 can be installed on any PC that is connected to both your Myriad network and the Internet. 
You can install OCP 5 on the same machine as Myriad providing that it has access to the web. 
To install OCP 5 visit: 
https://www.broadcastradio.com/myriad-5-playout-support#Download 

 

Click on the Current Full Release button and select OCP 5 from the popup list. 
This will download the installer files to your standard ‘Downloads’ folder. To install (you will need 
Admin permissions) simply double click on this installer file. 
Follow the on screen instructions and select typical set-up when prompted. 
Once the installation process is complete you are ready to launch OCP 5. 
 

Running OCP 5 For The First Time 
OCP 5 does not require a license to run (as it is designed to work with licensed Myriad 5 Playout 
workstations) so you will not be asked to enter any license details. Instead you will proceed directly 
to application setup. 
 

If you have Myriad 5 Playout already setup on this PC 
 
If you have Myriad 5 Playout installed on the same PC then OCP 5 will automatically detect this and 
use the same settings to configure itself. If you have multiple Profiles installed on your system, you 
will be asked which Profile to use. 
 

 
 

https://www.broadcastradio.com/myriad-5-playout-support#Download
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Once you have selected the desired profile, or you only have one Profile configured, OCP 5 will next 
ask you to select the Station Database you want to use. In most cases you will only have one (even if 
you operate multiple Stations within that single database). 
 

 
 
Select the Station Database you want to use and click on OK. 
 

If you do not have Myriad 5 Playout installed on this PC 
If you have not got Myriad 5 Playout installed on the PC that you are running OCP 5 on, you will be 
asked to set the SQL and Data locations for your central Myriad 5 system. 

 

If you are not sure what these should be, go to a PC that has Myriad 5 Playout configured and check 
the Settings Menu > Applications Settings. The locations you need can be found on the Data 
Locations tab. 
 
Once you have entered the correct file path location and SQL connection details, you will be directed 
to select the appropriate Profile and Station Database as outlined in the previous section. 
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OCP 5 is now ready to start setting up Stations and Outputs. 
 

 
 

Adding A Station To OCP 5 
Before you can configure Myriad 5 Playout to connect to OCP 5, you need to add a Station to OCP 5 
that Myriad can connect to. 
 
Click on the Stations Menu and select Add Station. 
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Next you will see a list of Stations that are available within your Station Database. We will select Hot 
Digital in this example. 
 

 
 
The Station will be added to OCP 5 using the most common settings. 
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Adjusting Station Settings 
To adjust the Station Settings, click on the settings button to the top right of the station to extend 
the drop down option menu, then select Station Settings. 
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This will open the Station Settings window. 
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Automatically Start Station 
 

 
 
You can select whether OCP 5 should automatically start sending information for this Station when 
the applications starts using this Yes / No option. 
 
You can also set whether the Station should appear in full of collapsed view be default on ‘start up’. 
 

The General Tab 
The General Tab allows you to adjust a range of general settings for the selected Station. 
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The options are: 
 

• OCP Station Reference – This is a unique reference that Myriad 5 Playout and OCP 5 use to 
identify the correct OCP 5 Station for the playout system to update. You should set this to be 
something obvious (HotDigital for example) and make a note of it as you will need to enter it 
exactly as it is here, in the Station Settings section of Myriad 5 Playout. It is worth copy / 
paste when the time comes to ensure they match exactly. 

• Image File Name To Use When No Image Is Associated – Enter a path and file name for a 
suitable image file for OCP 5 to use when an audio item does not have an image associated. 
Please note this is not used by the Broadcast Radio MyStation Web Player or Mobile Apps. 

• Log DAB & Serial To – Allows you to select a folder that OCP 5 will use to generate log files 
for DAB and Serial text processed. 

• Source Text Options – Offers options for OCP 5 processing the text information it receives 
from Myriad 5 Playout: 

o Remote Any Text Between < > From Title & Artists – OCP will automatically remove 
any text that is sent to it that appears between the < > brackets. For example Love 
Machine <Radio Edit> by Girls Aloud will appear as Love Machine by Girls Aloud 
once the text is processed by OCP 5. 

o Remote Any Text Between < > From Presenter & Show Fields – OCP will 
automatically remove any text that is sent to it that appears between the < > 
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brackets. So Mark’s Breakfast <Clock 1> will be displayed as Mark’s Breakfast after 
OCP has processed the text. 

• Travel Information – Allows OCP5 to send a special ‘travel’ output to certain devices (such 
as RDS encoders) then a Media Item is played that contains the specified trigger word. You 
can also set how long to ‘hold’ the traffic flag after the item has finished.  

 

The Updates Tab 
The Updates tab allows you to alter the way OCP 5 updates the information for a Station. 
 

 
 

• Automatically Re-Send Outputs Periodically – Under normal circumstanced, OCP 5 will 
update an ‘output’ then the Myriad 5 Playout indicates that the ‘current content’ has 
changed. This series of options allows you to override this so that specific Outputs are 
updated automatically every X seconds. This option is most often used in conjunction with 
Carousel files on DAB outputs. 

• Update Options – Allows you to select additional criteria that will trigger an OCP 5 Output 
update. 

 

Social Media Tab 
The Social Media tab allows you to add the Social Media credentials used to allow OCP 5 to post 
content to Facebook and Twitter. 
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Authenticate Facebook 
To authenticate OCP 5 to be able to use Facebook, follow these steps: 
 
Clicks on the Authenticate button for Facebook. 
 

 
 
You will be asked to continue on to Facebook. Click on Continue With Facebook. 
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Next will be asked to login to Facebook with your normal Username and Password. 
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Once your credentials are accepted, your will be asked whether you wish to continue to proceed to 
Facebook. 
 

 
 
Next you will be asked which pages you with OCP 5 to be able to post to. 
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Tick the pages you want to use and scroll down to the bottom of the page and click Next. 
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You will then be asked what permissions should be granted to OCP 5. We recommend setting them 
all to Yes but read them and choose which you want to grant, then click Done. 
 

 
 
OCP 5 will now  be authorised to post content to your selected Facebook pages. 
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You can see that the Authentication is confirmed by OCP. 
 

 
 
Remember to select the Page you want to post to using the Page To Post To drop down. 
 
If you want to clear the credentials so that OCP 5 cannot post to Facebook, click on Clear 
Credentials. 
 

Authenticate Twitter 
The process for granting access to Twitter is similar to Facebook. Click on the Authenticate button in 
the Twitter section. 
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You will see a message box telling you that Twitter needs to open a webpage to authenticate OCP 5 
access. Click on Yes. 
 
Please note that second window will also pop-up which is used to enter the unique code Twitter 
provides but that is not used until later in the process so ignore that for now. 
 

 
 
A webpage will open in your default browser. Login to Twitter using your Twitter username and 
password. Type in your Twitter username and password and then click on Authorise App.  
 
Please note that is you are already logged into Twitter on the PC you are working on, you may not 
have to re-enter your username or password. 
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Once you have clicked on the Authorise button, Twitter will display a unique pin number that you 
need to make a note of. We commend copying it. 
 

 
 
Earlier you will have seen a separate windows popup that is asking for the pin number from the 
Twitter website, we said ignore it at the time! 
 



 Copyright © 2020 Broadcast Radio Ltd 21 

 
 
Now that you have the pin number from Twitter, type or paste it in here and click on OK. 
 
OCP 5 will now be authorised to post tweets to the selected Twitter account. 
 

 
 
You can remove the authorisation by clicking on the Clear Credentials button. 
 

Recent History Tab 
The Recent History tab shows a list of recent events logged in association with this Station. 
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Other Station Options 
In addition to the standard Settings you can also access other Station related options from the 
Station drop down menu. 
 

 
 

• Station Settings – Access the basic settings for the Station. 

• Manual Update – Manually override the information OCP 5 sends to the Outputs (good for 
testing). 

• Post Social Message To Twitter / Facebook – Manually send a message to Twitter or 
Facebook directly from OCP (good for testing) 
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• Import Output From OCP 4 / SE – If you have previously used OCP 4 or OCP SE and want to 
import your Outputs into OCP 5, you can do so with this option. 

• Display Current Information – This shows all the current and recent information that OCP 5 
has received from Myriad 5 Playout (good for diagnostics) 

 

 
 

Adding & Removing Stations 
If you are licensed for OCP 5 Pro then you can add more than one Station to your system. This is 
done via the Stations Menu 
 

 
 

Adding A New Station 
Unlike previous versions of OCP, all OCP 5 settings are actually stored centrally for each Station 
(within the overall Myriad Database). You can select what Stations are updated by individual OCP 5 
instances but all the settings are stored in the main Myriad Database. 
 
That means, in order to add a new Station, all you need to do is click on the Station Menu > Add 
Station option. 
 
You then select the Station you want to add to OCP from the list. 
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Removing Stations 
Removing a Station from OCP is equally simple. Click on the Station Menu > Remove Station option, 
select the station you want to remove from the list and click on OK. 
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Please note that this will remove the Station from this instance of OCP 5 but not remove the Station 
OCP settings from the Station Database making it easy to move to another instance of OCP 5. 
 

Setting Up Myriad 5 Playout To Send To OCP 5 
Now that OCP 5 is configured, it is time to setup Myriad 5 Playout to be able to send information to 
OCP 5. 
 
In Myriad Playout (logged in with a User account with sufficient permissions to alter the settings), 
click on Settings Menu > Database Settings > Database Setting then click on the Stations Tab and 
finally double click on the specific Station you want to setup OCP 5 for. 
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In the Edit Station Settings windows, click on the Connections tab. This tab allows you to setup the 
connections to a range of Broadcast Radio family products including OCP 5. 

Ignore the Send Now Playing Information To Myriad OCP SE setting, that is only used for OCP SE, 
not OCP 5! 

In the Station Connections area, click on the + button to drop down a list of potential connections 
and selects Myriad OCP v5 Connection from the list. 
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This will open the OCP 5 Connection settings for Myriad 5 Playout. 

 

Add the following details: 

• Computer Name / IP Address – You can add in the computer name or IP address of the PC 
that OCP 5 is running on. If OCP is running on the same PC then you can put in ‘localhost’. 

• Encoder External Reference – This is the unique reference that OCP and Myriad will use to 
ensure the correct information it passed to the correct OCP Station. This should be set to be 
exactly the same as the OCP Station Reference in the OCP Station Settings. 

• Connection Is Enabled – You can toggle whether the connection is enabled or not. 

When you are happy, click on OK and the OCP 5 Connection will be added to the Station Connection 
list. 

 

Testing The Connection 
Now that you have configured both OCP 5 and Myriad Playout, you can test the connection by 
clicking on the Off Air / On Air button in Myriad Playout. 

 

Click on the Off Air button (top right of Myriad Playout) to switch from Off Air to On Air. 
You will briefly see a 'OCP Connecting' warning as Myriad Playout connects to OCP 5. 
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TIP: If your connection to OCP cannot be established or if one or more Outputs fail to execute 
correctly, an orange warning panel is displayed in Myriad 5 Playout to warn the On-Air studio. 
 

 
 
If you switch to OCP 5, you will see that the top of the Station panel now has the current Now 
Playing information and you can also see which studio has On-Air control (Studio 1 in example 
below). 

 

If you do not see an On-Air / Off-Air button in Myriad Playout, it may be that you need to review 
your On-Air settings in Settings Menu > Application Settings then the On-Air Control tab. 
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Example 1: Setting Up Your First Text File Output In OCP 5 
Now that OCP 5 and Myriad 5 Playout are talking to each other, let us take a look at adding a simple 
output. In OCP 5, click on the Outputs tab. 
 

 
 
You can see that we already have a few Outputs setup in this example but lets add a simple File 
Output to that list. Click on the + button to add a new Output. 
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Next you will be asked what type of Output you want to add. Please note that the range of Outputs 
in standard OCP 5 is limited. A much wider range of outputs are included in OCP 5 Pro (see below). 

 

Let us add a simple file output which will take a 'template file' which contains special OCP Tags and 
replace these tags with 'Now Playing' information before updating a 'destination' file. 
 
Before we get started, we will need to create a template file and a destination folder. Create two 
folders (source & destination) in a suitable location.  
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In the Source folder, create a new text file called template.txt. 

 

In the 'template.txt' file and paste the following script in the text file. 
Now playing: <OCP_NOW_ARTISTNAMES> with <OCP_NOW_CART_ITEMTITLE> 
 
TIP: You can substitute CART with MEDIA in all OCP tags, either will work. 
 

 

Save the file, this will be your template file for the OCP 5 Output. 

Back on OCP 5, Select the File / FTP option and click on OK. 
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In the Files To Publish section, click on the New Files button to add in the Template and Destination 
file locations. 
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This will open the File window which allows you to browse to the Source (Template) and Destination 
File locations. 
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Click on the Browser button for the Source File and navigate to the 'source' folder you created 
earlier and select the Template.txt file.  
 

 

Next click on the Browse button for the Destination and select the folder you want to use for the 
destination file. Be careful to ensure it is different to the source location or you will overwrite the 
template file! 
 
Navigate to the 'destination' folder you created earlier and give your output file a name. Remember 
to set the 'Save As Type' field to the type of file you want to output. 

 

Review the settings then click on Save. 
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The File / FTP Output configuration window also allows you to setup automatic FTP upload for the 
output files but we will not be using FTP in his example. Click on OK to close the window. 
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You can now see the File /FTP Output has been added to the list of Outputs in OCP 5 and that the 
status shows that the Output file has been sucessfully updated. 

 

Let us take a look at the output.txt file OCP 5 has created. 
 

 
 
As you can see the <OCP_NOW_ARTISTNAMES> and <OCP_NOW_CART_ITEMTITLE> tags have been 
replaced with the correct information from Myriad Playout. 
 

Example 2: Setting Up The Broadcast Radio Player Output 
If you are using the BR Player to allow listeners to access your web steam (hosted with us) then 
there is a simple, built in 'Output' for directly connecting. 
 
You will need your unique API key which you can get from your BR Player Edit page. 
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To add a BR Player Output, click on the Add Output button. 

 

Selected the Broadcast Radio Playout output from the list. Please note that the screen show below is 
from OCP Pro so has an extended list of Outputs. OCP Standard will have a smaller list but the 
Broadcast Radio Player will still be available. 
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Next add your unique API key and Click OK. 

 

You will see the settings for Broadcast Radio Player Output but there is no need to change anything 
(in fact you should not change anything). Click on OK to complete the process. 
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There are no other settings required so your BR Player Output is now fully configured. 
 

 
Your BR Player should now show ‘Now Playing’ information. 
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Stations In More Detail 
Now that we have OCP 5 setup with a couple of simple Outputs, lets take a closer look at the 
Stations section of OCP and what options we have. 
 

 
 

1. Name of the Station (comes from the Myriad 5 Station Enabler). 
2. Latest ‘Now Playing’ information from the On-Air system. 
3. Time and date of most recent update. 
4. Station OCP Output active toggle. 
5. Access Settings and other options (see previous chapter). 
6. Force an update on all Outputs. 
7. Current Tab – Shows the current status of the Station. 
8. Output Tab – Shows current status of all outputs plus used to add or edit Outputs. 
9. Log Tab – Displays a log of recent OCP activity. 
10. Shows the status of Station related information. 
11. Output History – Shows a summary of Outputs status. 
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12. Outputs Tab – Allows you to view and manage Outputs. 
13. List of existing Outputs. 
14. Output status. 
15. Add an Output. 
16. Edit Output Settings 
17. Remove Output. 
18. Export Selected Output. 

 

 
 

19. Log Tab – Allows you to view recent history log. 
20. Recent history log. 

Outputs In OCP Standard & Pro 
Outputs are used to send information from OCP 5 to a variety of different platforms in different 
formats. We offer both generic Outputs (like File output) and platform specific outputs (like 
Facebook). 
 
Some Outputs are included in OCP 5 Standard whilst others are only available within OCP 5 Pro. 
Output availability is indicated by the padlock icon to the right of the Output. Outputs with a Padlock 
are not available in OCP Standard. Outputs without a Padlock are available.  
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The list of Outputs regularly changes as we add new Outputs or update existing Outputs. All OCP 
users will receive the following Outputs as standard. 
 

• File / FTP 

• Broadcast Radio Encoder 

• Broadcast Radio Myriad 5 Logging 

• Broadcast Radio MyStation 

• Broadcast Radio Player (Legacy) 

• Broadcast Radio Smart Sign 

• Icecast 
 
Please contact Broadcast Radio to discuss upgrading to OCP 5 Pro if you want access to additional 
Outputs. 
 
The list of available outputs will also differ depending on whether you have OCP 5 or OCP 5 Pro. 
 
To add an Output, click on the Add Output button. 
 

Importing & Exporting Outputs 
You can export Outputs from OCP 5 complete with all settings. This allows you to import them on a 
different OCP 5 system.  
 
To export an Output, click on the Outputs Tab select the Output you want to export and click on the 
Export button. 
 
Image here 
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You can also import previously saved ‘Outputs’ to the system by clicking on the Add Output button 
and then clicking on the Import button on the Select Output window. 
 

 
 
 

Adding The BR Player (Legacy) Output (Standard & Pro) 
 
If you are using the BR Player to allow listeners to access your web steam (hosted with us) then 
there is a simple, built in 'Output' for directly connecting. 
 
You will need your unique API key which you can get from your BR Player Edit page. 
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To add a BR Player Output, click on the Add Output button. 

 

Next add your unique API key and Click OK. 
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Next you will see the settings screen for the BR Player. Do not adjust these settings, they are pre-set 
to work with the BR Player.  
 

 
 
Please note that some fields cannot be edited in OCP Standard. 
 
Click on the OK button to save the settings. 
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Your BR Player output in now fully configured and Myriad 5 Playout will be able to update the Now 
Playing information on the BR Player. 

 
 

Adding The MyStation Output (Standard & Pro) 
MyStation is the replacement for the BR Player and offers a far more feature rich web players as well 
as providing the ‘back end’ data for our range of mobile apps. The process for adding a MyStation 
Output for OCP 5 is very similar to the BR Player. 
 
Click on the Add Output button and select MyStation Output from the list. 
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Next you will be asked to provide the unique API key for your MyStation account. 
 

 
 
To find this, login to your MyStation portal and navigate Settings menu and select Playout 
Integration. 
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You will see your unique API key in the top section. 
 
Copy your API key and then paste it into the API Key floating window in OCP. 
 

 
 
Then clock Ok. 
 
You will then see the settings window for your MyStation Output. Do not adjust these settings as 
they have been pre-set to the correct values. 
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Please note that some fields cannot be edited in OCP Standard. 
 
Click on OK and you will see that your MyStation Output has been added to the list of Outputs. 
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Adding The BR Encoder Output (Standard & Pro) 
Generally you will not need to use this Output as Myriad 5 Playout can send to the BR Encoder 
directly, but if you want to send something more complex than just the generic ‘Now Playing’ 
information you may wish to use this Output as it offers the same level of flexibility with the 
information and format of Output strings as all the other Outputs. 
 
To add a BR Encoder Output, click on the Add Output button and choose the BR Encoder form the 
list of available Outputs. 
 

 
 
 
Next you will need to provide the unique External Reference that you set in BR Encoder. 
 

 
 
By default this is Encoder1 but you may well of changed it when you setup your BR Encoder. 
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Once you have typed in the External Reference and click on OK, your BR Encoder Output is 
completed and ready to work…But… it is assumed that the BR Encoder is running on the same PC as 
OCP 5 so if that is the case then you have completed the setup and you can click on OK. 
 
If not then follow these steps: 
 

1. Type in the Name or IP Address of the PC Running BR Encoder Service into the Host field. 
 

 
 

2. Click on OK as there is no need to change any other settings (in fact doing so will probably 
stop it working!). 

 
Please note that some fields cannot be edited in OCP Standard. 
 
Do not adjust any of the other settings, they have be pre-set to connect to the BR Encoder service.  
 



 Copyright © 2020 Broadcast Radio Ltd 53 

 
 
Your BR Encoder Output is now setup. 
 

Adding The Myriad Logging Output (Standard & Pro) 
 
You can add an Output to OCP 5 that will automatically add ‘Now Playing’ text information to your 
Myriad 5 Logging system.  
 
Click on the Add Output button and select Myriad Logging from the list of available Output. 
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Next you will be asked for the Name / IP Address and Port for your Myriad Logging system. 
 
The default Port for Myriad Logging is 5001 so you should enter in the connect details in the format: 
 
Address:Port 
 
So for example if your Myriad Logging PC is named LOGGINGPC then you should enter: 
 
LOGGINGPC:5001 
 

 
 
No additional information is required to configure OCP 5 to connect to Myriad Logging so that 
Logging can log Now Playing info.  
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Please note that some fields cannot be edited in OCP Standard. 
 
Do not adjust these settings, they have been pre-set to work with Myriad 5 Logging. Click on OK, the 
Myriad 5 Logging Output has now been added to OCP. 
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Adding The SmartSign Output (Standard & Pro) 
 
You can configure OCP 5 to automatically send ‘Now Playing’ information to one or more Broadcast 
Radio SmartSigns at your station. 
 

Click on Add Output and select SmartSign from the list of available Outputs. 
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Next you will be asked for the Name / IP Address and Port for your SmartSign. 
 
The default Port for SmartSign is 8001 so you should enter in the connect details in the format: 
 
Address:Port 
 
So for example if your SmartSign is on IP address 192.168.1.20 then you should enter: 
 
192.168.1.20:8001 
 

 
 
Once you have entered the IP-address:Port  then click OK. 
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Please note that some fields cannot be edited in OCP Standard. 
 
Do not adjust these settings, they have been pre-set to work with Smart Sign. 
 
Please note that you may have multiple SmartSigns at your station. You will need to add an OCP 5 
for each SmartSign that you want to be sent ‘Now Playing information. 
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Adding Generic Outputs 
To add Outputs to OCP 5, click on the Add Output button. 
 

 
 
You will then see a list of available Outputs. Select the one you want to add and click on OK. 
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Once you have selected the Output, the settings window for the Output will automatically open. 
These settings differ from Output to Output with the most commonly used Outputs outlined in the 
next section. 
 
 

File / FTP Output (Standard & Pro) 
 
Now that OCP 5 and Myriad 5 Playout are talking to each other, let us take a look at adding a simple 
output. In OCP 5, click on the Outputs tab. 
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You can see that we already have a few Outputs setup in this example but lets add a simple File 
Output to that list. Click on the + button to add a new Output. 
 

 

Next you will be asked what type of Output you want to add. Please note that the range of Outputs 
in standard OCP 5 is limited. A much wider range of outputs are included in OCP 5 Pro (see below). 
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Let us add a simple file output which will take a 'template file' which contains special OCP Tags and 
replace these tags with 'Now Playing' information before updating a 'destination' file. 
 
Before we get started, we will need to create a template file and a destination folder. Create two 
folders (source & destination) in a suitable location.  

 

In the Source folder, create a new text file called template.txt. 

 

In the 'template.txt' file and paste the following script in the text file. 
Now playing: <OCP_NOW_ARTISTNAMES> with <OCP_NOW_CART_ITEMTITLE> 
 
TIP: You can substitute CART with MEDIA in all OCP tags, either will work. 
 

 

Save the file, this will be your template file for the OCP 5 Output. 

Back on OCP 5, Select the File / FTP option and click on OK. 
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In the Files To Publish section, click on the New Files button to add in the Template and Destination 
file locations. 
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This will open the File window which allows you to browse to the Source (Template) and Destination 
File locations. 
 

 
 
 



 Copyright © 2020 Broadcast Radio Ltd 65 

Click on the Browser button for the Source File and navigate to the 'source' folder you created 
earlier and select the Template.txt file.  
 

 

Next click on the Browse button for the Destination and select the folder you want to use for the 
destination file. Be careful to ensure it is different to the source location or you will overwrite the 
template file! 
 
Navigate to the 'destination' folder you created earlier and give your output file a name. Remember 
to set the 'Save As Type' field to the type of file you want to output. 

 

Review the settings then click on Save. 
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The File / FTP Output configuration window also allows you to setup automatic FTP upload for the 
output files but we will not be using FTP in his example. Click on OK to close the window. 
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You can now see the File /FTP Output has been added to the list of Outputs in OCP 5 and that the 
status shows that the Output file has been sucessfully updated. 

 

Let us take a look at the output.txt file OCP 5 has created. 
 

 
 
As you can see the <OCP_NOW_ARTISTNAMES> and <OCP_NOW_CART_ITEMTITLE> tags have been 
replaced with the correct information from Myriad Playout. 
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HTTP GET /POST Output (OCP 5 Pro only) 
 
Another commonly used  Output from OCP 5 Pro is the HTTP GET/POST output which can be used to 
communicate ‘Now Playing’ information with a variety of devices and web services that 
communicate via standard web protocols. 
 
Click on the Add Output button and select HTTP GET/POST from the list. 
 

 
 

 
This will open the settings window. 
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1. Host - Choose from HTTP or HTTPS. 
2. Server Name – Set the Server Name or IP Address you need to connect to. 
3. Port: Set the Port that should be used for the connection. 
4. URL (inc path) – Add any addition path URL information that may be required for your 

Output. 
5. Login Name – Add a Login name and Password if required. 
6. Request Method – Choose between a GET and a POST method. 
7. Send Options – Set the criteria OCP uses to trigger an update. 
8. Output Format – Build the output string OCP will send using a mixture of characters and OCP 

Tags. See Format Builder. 
9. Add a string that will be appended to the end of the Output. 
10. Launch the Format Builder (see later chapter). 

 

Social Posts 
Previous versions of OCP 4 and OCP SE required a Social Media output but the connection to 
Facebook and Twitter is natively built into OCP 5 so as long as you have setup your Facebook and 
Twitter authentication (see Quick Start) then Myriad 5 Playout will be able to post content to these 
platforms. 
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IP or RS232 (OCP 5 Pro only) 
If you want OCP 5 to communicate with an external device, this is often done using the IP or RS232 
Output. 
 
Click on the Add Output button and select the IP/Serial from the list. 
 

 
 
This Ouput can be used to send informaion on three formats: 
 

• Serial (RS232) – Typically used for RDS or legacy devices. 

• TCP – Used to communicate with network devices. 

• UDP – Fast, single direction network protocol. 
 

Adding A Serial Output 
The same settings window is used for Serial / TCP and UDP Outputs as they are conceptually the 
same but the settings are slightly different. To add a Serial Output, first select Serial  from the Mode 
drop down. 
 
You can then fill in the rest of the settings you need for sending information to your Serial device. 
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1. Mode allows you to change the Output between Serial, TCP and UDP. The selection will 
change the settings options in the window. 

2. COM – Set the communications port (COM Port) to use. 
3. Set whether the device you are connecting to is expecting ‘handshaking’. 
4. Set the communication speed and format (Baud Rate,Parity,Data Bits,Stop Bits). 
5. Set whether the connection should be closed immediately after each update or kept open 

for a short time. 
6. Allows you to set options to restrict the maximum length of update as well as what to do if 

the update contains no information. 
7. You can also set the ‘Travel Flag’ start and end message format to match the format your 

device is expecting. The Travel Flag is triggered when an update starts with the key word set 
in Station Settings. 

8. You can also set a suffix which will be appended to the end of each message. 
9. Output format allows you to set the format of the update to be sent. This is done using a 

combination of standard characters mixed with special OCP Tags that will be replaced with 
‘live’ information. For more details see Format Creator. 

10. Open the Format Creator which is a tool to help you build the Output Format (See Format 
Creator chapter). 



 Copyright © 2020 Broadcast Radio Ltd 72 

11. You can also add an alternative text string to Output that can be used to either fill in when 
the main Output results in an empty string, or to automatically cycle through creating a 
carousel of information. See Alternate Strings & Carousel Files. 

12. This tickbox is used to set when the alternative string is used. If ticked then the alternative 
string section is only used if the main Format Output will result in a totally empty value. If 
this option is left unticked, but the Output is set to refresh periodically then each time it 
refreshes (without the content from Myriad being different) then a random string from 
either the main Output or one of the Alternate Outputs will be displayed. 

13. This option allows you to build a list of Alternative Strings or point OCP at a specially 
formatted ‘carousel file’ that contains a list of date/time restricted strings. For more detail 
on this see Alternate Strings & Carousel Files. 

 

 
 

Adding An TCP Output 
This option is very similar to the Serial Output but the communication method uses TCP/IP 
networking instead of RS232. TCP is often used to communicate with modern, network enabled 
devices. 
 
To add a TCP Output, select TCP  from the Mode drop down. 
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As you can see, the only section that changes is the top section where you need to set the address 
and port number for OCP to send the Output to. 
 

1. Address – time in the IP address that OCP needs to send the Output to. 
2. Type in the unique port that OCP will use to send the Output to. 

 
This information will be unique for each device and network location. 
 

Adding A UDP Output 
Whist both Serial and TCP connections can be considered ‘two way’, a UDP connection can be 
thought of as a ‘directed broadcast’ in that OCP will send the Output to the selected IP address and 
port but will not wait for confirmation that it is received. Please consult your devices documentation 
to determine whether to use TCP or UDP. 
 
To setup a UDP Output, select UDP from the Mode drop down. 
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As you can see, the UDP settings are very similar to both Serial and TCP Outputs. 

1. Address – time in the IP address that OCP needs to send the Output to. 
2. Type in the unique port that OCP will use to send the Output to. 
3. Notice that the options related to closing the connection are missing from the UDP Output. 

That is because with UDP, a connection is never established, rather OCP just sends the 
Output to the IP address blindly. 
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Icecast Output (Standard & Pro) 
 
The Icecast Outputs allow you directly embed ‘Now Playing’ information into your Icecast streams. 
This information is often used by 3rd party ‘player applications’ to display now playing information. 
 
To add a Icecast Output, click on the Add Output button and select Icecast from the list. 
 

 
 
Next you will be asked to enter the address of you Streaming Server. Type in the address supplied by 
your streaming provider. 
 

 
 
Make sure you don’t include the HTTP:// prefix . 
 
You will then be prompted to enter the unique Port for your stream. Again, this should be supplied 
by your streaming provider. 
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Once the Port is set, you will be asked to type in your connection password. This needs to be exact 
so we recommend pasting it in. 
 

 
 
Finally you will be asked for your stations unique Mountpoint. Your streaming provider will be able 
to supply this information. 
 

 
 
When you click on OK in this final window, you will see the overall settings for the Icecast Output 
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1. The top section contains the information that you entered in the four initial question 
windows. If you need to alter any of the details, you can do so here. 

2. This is the specific settings for connecting to an Icecast server. The only setting you should 
adjust in this section is the password (if you need to). 

3. The Output Format determines the format of the information that will be sent to Icecast. 
The default will be ‘Song Title’ by Artist Name. For more information on adjusting this 
Output Format see Format Creator. 

 
You should not need to adjust any of these settings. Click on OK to save the settings. 
 

DAB Output (OCP Pro Only) 
 

The DAB Output allows you to use OCP 5 to encode text in to the data stream of a DAB 
(Digital Audio Broadcast) transmission. This is also sometimes known as DLS (Dynamic Link 
Segment) text. 
 

In theory, DAB transmissions can include a wide range of additional text and picture 
information but at present, most DAB receivers can only decode text from the data stream. 
In addition, the method for encoding the text into the data stream has not been agreed as a 
standard so the method can vary in different Countries or even across different service 
providers. In the UK, the majority of DAB transmission service providers use a specification 
developed by RadioScape™ and it is this standard that OCP 5 also uses. 
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To begin adding a DAB Output, click on the Add Output button and then select DAB Output 
from the list of available Outputs. 
 
 

 
 
This will open the DAB Output settings window. 
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1. Host - Type in the Host field allows you to type in the network name or IP address of the DAB 
service that OCP will send Outputs to. 

2. Port - Add in the specific Port that OCP will use to send data. 
3. Service name – Add in the service name used to connect to the service (this and the 

password will be provided by your service provider). 
4. Password – Set the password needed to connect.  
5. Limit Characters – This setting allows you to place a maximum limit on the amount of 

characters that will be included in the Output. 
6. Message Suffix – You can also add a suffix that will be automatically added to the end of the 

Output. 
7. Output Format – This allows you to set the Ouput string using a combination of characters 

and OCP Tags. You can use the Format Creator to aid with building this Output. 
8. Launch Format Creator – Accesses the Format Creator which is used to build Output strings 

using a combination of characters and OCP Tags. See separate section on Format Creator. 
9. Alternate String – You can also add additional strings or a link to an external ‘carousel file’ 

that contains additional (date time sensitive) information. This is most commonly used to 
create a carousel of information on displays such as DAB radios in cars. See Alternate Strings 
& Carousel Files for more information. 

10. Alternate String Builder - Allows you to build your Alternate Strings or select a Carousel file. 
11. Remove Alternate String – Removes the selected Alternate String. 
12. Only Use When Empty – This option allows you to tell OCP to only use the Alternate string if 

the main Output Format is totally blank. 
 
Once you are happy with the DAB Output settings, click on OK to add the Output. 
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Other 3rd Party Outputs (OCP Pro Only) 
 
There are a number of other Outputs in OCP 5 Pro that are not covered in this documentation 
although all of them will be a variation on an Output that is covered so you can get the relevant 
information. 
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Most of these Outputs have been added for a specific device or service and the majority of them will 
require OCP 5 Pro to access them. The list of supported 3rd party Outputs changes regularly so please 
update to the latest version of OCP 5 to see a complete list. 
 

Output Formats & The Format Creator 
In all the Outputs covered so far there is a section in the settings called the Output Format which is 
used by OCP to generate the output text string that is sent to the destination for the Output. The 
same is also true of the Alternate Strings and even the Carousel files. 
 
These ‘Output Strings’ combine standard text with special OCP Tags that are replaced with ‘live’ 
information before the Output is sent to its destination. 
 
You can even add advanced features such as ‘IF’ conditions using OCP tags so you could have an 
Output that displays the name of a Song when a Song is playing but changes to ‘Now from our 
sponsors’ when an advert is playing. 
 
Take a look at Output Script used in the simple File / FTP Output example used earlier. 
 

 
 
Typing even this simple script by hand would be time consuming and prone to errors so instead we 
recommend you use the special Format Creator tool to create all Output Scripts for all Outputs. 
 

Accessing The Format Creator 
You can access the Format Creator directly in each Output (except File / FTP) using the Open Format 
Creator button. 
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You can also access the Format Creator from the File Menu in OCP. 

 
 
 
 

The Format Creator 
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1. Available Tags - You can view a list of all available OCP Tags using the tree view on the left 
hand side. 

2. Edit Area - This is the script edit area that allows you to view and edit the scripts. 
3. Tag Scope - This allows you to set the scope of the OCP tags you are editing. So if you select 

Current Item then add a Artist Name tag, the OCP Tag will be <OCP_NOW_ARTISTNAMES> 
which means show the Name(s) of the ‘now playing’ artists. If you changed this drop down 
to Previous Item or Next Item, the tag would change to <OCP_PREVIOUS_ARTISTNAMES> or  
<OCP_NEXT_ARTISTNAMES> correspondingly. 

4. Smart-Edit - With this option ticked, the Format Creator will attempt to assist and correct 
formatting errors in your scripts. 

5. Preview – Shows an ‘real time’ preview of the Output your script will result in (based on 
most recent update from Myriad Playout). 

6. Notes- Displays some additional information to help you use the format creator. 
7. See List Of All Available Tags – This opens a text file containing a full list of all available OCP 

tags. 
  
You can type in the format you need in the in the Format area and then use the OCP tags on the left 
hands side to add the OCP tags.  
 
So, let’s say we wanted to create an output Format that resulted in: 
 
Now playing is (Song Title) by (Artists), followed by (Next Artist) 
 
We could type in the first part into the Format area. 
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The next bit we need it the OCP Tag for the currently playing item title.  
 
Make sure the scope is set to Current Item then double click on the Item Title option in the left list. 
 

 
 
This will result in the tag <OCP_NOW_ITEMTITLE> being added to edit area. 
 

 
 
Next add in ‘by’ and use the same technique to add in the Artist Names tag. 
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For the final OCP Tag we need to change the scope to Next Item as we don’t want the currently 
playing Artist, we want the next Artists to play. 
 
Change the scope to be Next Item then double click on the Artists Names option in the left list. 
 

 
 
If Myriad Playout is connected to OCP and supplying updated information, you will see the Preview 
area will show you an example of your Output Script using the most recently supplied information. 
 

 
 
The Format Creator allows you to explore the various OCP Tags that are available and construct the 
correctly formatted Output without need to type in all the OCP tags. 
 
If you want to browse a full list of available OCP Tags, click on the See A List Of All Available Tags  
button. 
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The list will open in your default text editor. 
 

 
 

More Advanced Formats – Conditional Statements 
 

So far we have seen a very simple Format String generated using the Format Creator to 
determine what information is sent to a range of Outputs. 
 

Throughout this first example, we assumed that the current and next items were both Songs 
but what would happen if the current item were a Song but the next was an advert for 
cheeseburgers. In our simple example, the information sent to the Encoder could look like: 
 

Now playing Crazy by Britney Spears followed by McDonald’s Enjoy A Big Mac  
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This is probable not what either you or the advertiser had in mind but with OCP 5 you can 
build in conditional statements using the Format Creator to deal with different item types 
differently. 
 

We are starting to get a little more complicated now but keep with it as once you have this, 
it can be a really powerful tool and allow you to do some very advanced things with OCP 5. 
 

First let’s get the syntax out of the way. When using conditional statements in the Format 
Creator, we basically create a different Format String for each of the conditions that we want to 

use, encapsulate each of these strings in [ and ] and start each with the condition that we 
want to be met in order for OCP 5 to use this section. This bit is encapsulated in ( and ). So in 
English we want: 
 

[(If current item is a song) display Now Playing Song Title by Artist] [(If current item is an 
advert) display Sponsored by Advertiser’s Name] 
 

So if the current item is a Song then display the normal information but if the current item is 
an Advert, change the text to say Sponsored by and then the Advertisers name. 
 

The actual script we would use is 
 

[(<OCP_NOW_ITEMTYPE>=Song) Now Playing: <OCP_NOW_ITEMNAME> by 
<OCP_NOW_ARTISTS>] 
 

[(<OCP_NOW_ITEMTYPE>=Advert) Sponsored By: 
<OCP_NOW_ITEMNAME>] 
 

In this case, if the current item is a Song then the first section would be used. If the item is an 
advert the second section would be used (we are also assuming that the advertisers name was 
in the Item Name in Myriad). 
 

You can also use =! which means ‘not equal to’ and if you leave the condition as blank then 
OCP 5 treats it as empty. This means that if we added an additional line of: 
 

[(<OCP_Next_ARTISTS>=!) Coming soon: <OCP_Next_ARTISTS>] 
 

In this example, if the  Next Artists information is provided by Myriad Playout then OCP 5 
will add ‘Coming soon Britney Spears’ to the end of the Output string but if Myriad does not 
provide an Artist Name for the Next item then nothing would be displayed as the condition 
for this section would not be met. 
 

Finally, you can add additional Format Strings by putting the #### characters in to the 
Format Creator to signal to OCP 5 that this is that start of a new Format String. 
 

Please note that you cannot ‘nest’ conditional statements so it is not possible to have two 
conditions within a single section. 
 

N.B. Because ( ) and < > and [ ] are used by OCP 5 to signal sections of the Format String, if 
you need to use them in any text that you want in the string, you need to add two of them 
e.g. [[ will be ignored by OCP 5 and displayed as [ on the final output. 
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Alternate Strings & Carousel Files (OCP Pro only) 
Certain OCP Pro Outputs include the ability to add Alternate Strings or Carousel files to allow OCP to 
Output alternative or additional information when certain criteria are met. The Output types that 
this applies to are: 
 

• DAB Outputs 

• IP/Serial Outputs 
 
The main use for this when you are using an Output to send information to a dynamic receiver such 
as a DAB radio or Dynamic RDS radio. These devices have the ability to update the text displayed 
periodically so that different information is displayed. 
 
A good example would be a DAB radio. When a new Song is played, OCP will always Output the main 
information first (usually Song Name by Artists) but with the correct setup, 10 seconds later the 
information may change to display the name of the show or presenter, then 10 seconds later it may 
display a promo for the breakfast show etc. 
 
This type of effect can be achieved using the Alternate String or Carousel files. In this example we 
will use the DAB Output but the same process can also be used on the IP/Serial Output. 
 

 
 

Triggering Alternate Strings 
There are two things that can trigger the use of Alternate Strings (or Carousel files) in OCP 5 Pro. 
 



 Copyright © 2020 Broadcast Radio Ltd 89 

1. The main Output text results in a totally empty string – i.e. if Alternate string is not used, 
nothing will display. 

2. You set the Output to update periodically (every x seconds) in the Station Settings. 
 

Empty Main Output 
Let’s deal with the first scenario. Usually OCP will use the Output Format in the main section to build 
the text string that will form the Output. This will normally be a combination of text and OCP Tags 
which OCP replacing the OCP tags with ‘live’ information provided by Myriad Playout. 
 

 
 
So in the example above, the main Output format text is: 
 
[(<OCP_NOW_ITEMTYPE>=Song)<OCP_NOW_ITEMTITLE> by 
<OCP_NOW_ARTISTNAMES>...<OCP_NOW_NOTES>][(<OCP_NOW_ITEMTYPE>!=Song)<OCP_NOW_I
TEMTITLE>] 
 
This is known as the main Output string and was built using the Format Creator.  
 

 
 
So in this case, if Myriad Playout tells OCP that a Song called ‘Back in black’ is playing by AC/DC then 
(and there are no additional notes) then the Output sent from OCP would be: 
 
‘Back in black by AC/DC…’ 
 
If however, Myriad Playout tells OCP that an Jingle is playing and the jingle title is ‘Sweeper 1’ then 
the Output would send: 
 
‘Sweeper 1’ which would not be a lot of use! 
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You could of course change the main Output String to use something generic whenever a Song is not 
playing. So an example could be: 
 
[(<OCP_NOW_ITEMTYPE>=Song)<OCP_NOW_ITEMTITLE> by 
<OCP_NOW_ARTISTNAMES>...<OCP_NOW_NOTES>][(<OCP_NOW_ITEMTYPE>!=Song)More music 
soon! 
 
In this case, whenever a Song is not playing (ie a jingle, advert etc is) then OCP will simply output the 
following text: 
 
‘More music soon!’ 
 
This is fine could get repetitive so you could use the Alternate Strings section to add a few variations 
on this so that DAB radios display different messages between Songs. Consider the settings below: 
 

 
 
We can see in the main Output String, there is nothing listed after the 
(<OCP_NOW_ITEMTYPE>!=Song) section which means the main Output String will be totally empty. 
 
But we can also see that we have added some Alternate Strings and crucially we have ticked the 
Only Use these Alternative Strings  when the script command is empty option. 
 

 
 
So in with this configuration, when a Song is playing, OCP will send the ‘Song by Artists’ but when an 
item other than a Songs is playing, it will randomly display one of the Alternate Strings listed. 
 

Output Set To Update Periodically 
The other scenario that will trigger the use of Alternate Strings is if you have set the Output to 
update periodically in the Station settings. 
 
To view this settings click on the Station Settings ‘cog’ and select the Station Settings from the drop 
down menu. 
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Next switch to the Updates tab. 
 

 
 
In this example, the DAB Output has been set to automatically update every 10 seconds. This setting 
changes the way that OCP deals with updates whenever Myriad Playout informs OCP that the 
currently playing item has changed. The sequence is: 
 

1. When the currently playing item changes in Myriad Playout, it will send the details of the 
new current item to OCP. 
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2. OCP will always use the main Output Script on the first update after the current item has 
changes (so the first update may well be ‘Back to black by AC/DC’). 

3. Then 10 seconds later, OCP will perform another update on the DAB Output where it will 
randomly choose to use either the main Output Script or one of the Alternate Scripts (or 
something from the carousel file if configured). 

4. This selection will continue to repeat every 10 seconds until the next update from Myriad 
Playout. 

 

Adding Alternate Scripts 
Now that we know the conditions under which Alternate Scripts should be used, we can review how 
to add them! 
 

 
 
In the DAB or IP/Serial Output Settings, click on the Alternate Scripts Settings Cog and select Add 
Text from the drop down menu. 
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Please note that you can use plain text, OCP tags or a combination of both (see Format Creator). 
 
You then type in your script into the pop-up dialogue box and click on OK. 
 

 
 
Your Alternate Script will be added to the list. 
 
You can also remove an Alternate Script by highlighting it then clicking on the Remove Script button. 
 

 
 

Carousel Files 
An alternative to using the Alternate Scripts detailed above it to use a specially formatted Carousel 
file. 
 
A Carousel file is a file that contains a number of Alternate scripts along with some additional 
information about when they are valid to use. 
 
Alternate Scripts work well for generic messages but what if you wanted to display a message 
something like ‘Listen to Monday Madness today from 3pm’? This would not be possible with a 
Alternate Script (at least not having it only play on Mondays!) but a Carousel file contains 
information when scripts can be used as well as the scripts themselves. 
 

Adding A Carousel File 
To add a Carousel file, you need to click on the Alternate Strings Settings Cog and select Add 
Carousel File from the drop down list. 
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You can now browse to the location of your Carousel file. 
 

 
 
As you can see, the Carousel file has been added to the Alternate String list which means that each 
time the Output updates (without the current item changing), it will randomly choose something 
from the Alternate Strings list including the Carousel file. If the Carousel file is selected then a valid 
entry is randomly selected from the list in the file. 
 
It would be more common to have only Carousel file in the Alternate Script list as that way you can 
be assured your Carousel file scripts are being used. 
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You can remove a Carousel file by selecting it and then clicking on the Remove Alternate Script 
button. 

 
 

Carousel File Format & Layout 
A Carousel file should be a standard text (.txt) file with a suitable name and location. 
 
Let’s take a look at the Carousel file we used in the previous example. 
 

 
 
You can see the text that included in the file and replicated below: 
 
MoTuWeThFrSaSu |00-23| <OCP_SPECIAL_NOW_DDDD DD MMM YYYY HH:NN>  

MoTuWeThFrSaSu |00-23| Hot FM - The Best Music for a 

<OCP_SPECIAL_NOW_DDDD> 

MoTuWeThFrSaSu |00-23| Hot FM - The Best Music for 

<OCP_SPECIAL_NOW_MMMM> 

MoTuWeThFr     |05-08| Have Breakfast with Hot FM 

MoTuWeThFr     |09-16| Workin' 9 to 5 with Hot FM 

MoTuWeTh       |17-19| Drive home with Hot FM 

Fr             |17-19| Drive home for the weekend with Hot FM 

Fr             |17-23| Spend the weekend with Hot FM 

SaSu           |00-23| Spend the weekend with Hot FM 

 

Each line with the Carousel file is a separate Script and each Script is divided into three 
sections which are separated by the pipe or ‘|’ character (next to the z on a keyboard). The 
format of lines within a Carousel file is as follows: 
 

Valid Days | Valid Times | Filler text or tags 
 

Valid Days: Each day is represented by a short day code and you must include the code for 
each day on which you want the Filler to be valid. 
 

So for example: 
 

MoTuWeThFrSaSu – The Script would be valid on every day of the week. 
 
MoTuWeTh – Script would only be valid on Monday, Tuesday, Wednesday and Thursday. 
Fr – Script would only be valid on a Friday 
 



 Copyright © 2020 Broadcast Radio Ltd 96 

Valid Times: Allows you to create a single time band within which the Script is valid. 
 

So for example: 
 

00-23 – Script is valid 24 hours a day. 
05-08 – Script is only valid from the 5am to 8am (inclusive) hours 
 

Please note that you can only set a single time band per Scrip but of course you can add 
multiple Fillers to cover different time bands. 
 

Text Filler or Tags: You can use straight text or OCP 5 tags in this section. 
This is the information that OCP 5 will use to generate the DAB or IP/Serial Output. 
 

So by putting it all together you can control exactly when any script in the Carousel file can 
be used by OCP 5. 
 
MoTuWeThFr |09-16| Workin' 9 to 5 with Hot FM 

 

So the above Script can be used by OCP 5 from 09 to 16:59, Monday to Friday and when it is 
selected, OCP 5 will display ‘Workin’ 9 to 5 with Hot FM’ on DAB and IP/Serial Output. 
 

When OCP 5 is using a Carousel file to select the data for an output, it randomly selects a valid 

Script from the list but because you can add duplicates to the Carousel file, you can make 
important Scripts come around more often than others. 
 
MoTuWeThFrSaSu |00-23| Now playing <OCP 5_Now_Artists> with <OCP 

5_Now_ItemTitle> MoTuWeThFrSaSu |00-23| Best music on Hot FM 

 

MoTuWeThFrSaSu |00-23| Now playing <OCP 5_Now_Artists> with <OCP 

5_Now_ItemTitle> 

MoTuWeThFrSaSu |00-23| Listen to Dave in the morning on Hot FM 

 

MoTuWeThFrSaSu |00-23| Now playing <OCP 5_Now_Artists> with <OCP 

5_Now_ItemTitle> 

MoTuWeThFrSaSu |00-23| 99.9FM Hot FM – Hot hits all day 

 

Consider the Carousel file example above. There are three identical Scripts that include OCP 
5 tags for the Artists and Item Title. These would result in something like: 
 

‘Now Playing: Owl City with Fireflies’ 
 

The other three Scripts are just random text information. 
 

When using this Carousel file, OCP 5 would randomly select one of these six Scripts each 
time it is instructed to but because three are the same it means that statistically, every 
other OCP 5 update would be ‘Now Playing Owl City with Fireflies’. 
 
Carousel files are just plain text files so you can create them in Notepad or any other simple test 
editor. Don’t forget you can also use the Format Creator to create more complex strings that include 
OCP tags. 
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Conditional Statements in the Format Creator is relatively advanced concept that does 
require some familiarity with logical programming.  
 
We recommend some experimentation to get what you want from the system. 
 
Once you have your Output String correct, you can copy it and use it in any relevant Output 
String, Alternate String or Carousel File. 
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Removing Outputs From OCP 5 
 

So far we have spent a lot of time looking at how to add the various Output types to OCP 5 
but now we will look at how to remove an Output that has been added previously. 
 

Thankfully, removing Outputs from OCP 5 is a lot simpler than adding them in. To remove an 
Output, select the Output you want to remove and click on the Remote Output button.  
 

 
 
 
You will be asked to confirm before the Output is deleted. 
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Editing A Previously Configured Output 
 

To edit the settings for an existing Output, select the Output and click on the Edit Output 
button. 
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Or just double click on it to open its properties window. 

Forcing A Manual Update 
In general, OCP 5 will only send new updates to the configured Outputs when it receives 
confirmation from Myriad that the information has changed (usually after a segue between 
two items in Myriad). 
 

You can however, force OCP 5 to update all of the Outputs by clicking on the Force An 
Information Update button located on the Station window. 
 

 
 

Edit Station Settings 
You can change the settings for the OCP 5 Settings by clicking on the Station Settings Cog 
and selecting Station Settings. 
 

 
 

Manually Updating Information 
You can manually enter information and force an update using the Manual Update option on the 
Station Settings Cog drop down. 
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This will open the Manual Update window which allows you to manually override the data to be 
sent to Outputs. This is especially useful when testing OCP Outputs. 
 

 
 
You can manually edit the information for Preview / Current / Next and the click on the Update 
Now Playing button. 
 

Manually Post To Social Media Outputs 
You can manually send an Output to the configured Social Media platforms using the Post a Social 
Message option on the Station Settings Cog drop down. 
 

 
 
This will open the Social Media Post window. 
 
 



 Copyright © 2020 Broadcast Radio Ltd 102 

 
 
You can type and message and then send it to Twitter, Facebook or both. This is useful for testing 
OCP Social Outputs. 
 

Display Current Information 
You can see a display of the most recent information received from Myriad Playout using the Display 
Current Information option on the Station Settings Cog. 
 

 
 
This will show the previous 50 updates received from Myriad Playout along with the next 50 items 
scheduled to play. 
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The File Menu 
 

The File menu gives access to a range of File, Service and Outputs related options in OCP 5 
 

 
 

• Change Myriad Database – This allows you to select a different Myriad Database (not 
Station). 

• Format Creator – Provides access to the Format Creator Tool. 

• Exit – Closes OCP 5. 
 

The Stations Menu 
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• Add Station – Allows you to add another Station up to the maximum allowed in your Myriad 
Station Enabler code. 

• Remove Station – Allows you to remove a configured Station. 

• Expand All Stations – Expands all listed Stations to allow you to see the details. 

• Collapse All Stations – Collapses all Stations so you only see a summary line for each in the 
main view. 

• Start All Stations – Starts all Stations Outputs. 

• Stop All Stations – Stops all the Stations from generating Outputs. 
 

The Media Menu 
 

 
 

• Media Browser – Opens the Myriad 5 Playout Media Browser to allow you browse the 
content on your Media Wall. 

 

The Settings Menu 
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• Provides access to the OCP Settings window. 
 

 
 

1. Myriad Data Tab – Allows you to set the specific file and data locations for your Myriad 
Playout system. 

2. SQL Connection Details – Set the location of the SQL database Myriad Playout uses. Click on 
the cog to edit the settings. Check your Myriad Playout settings to get the correct 
connection details. 

3. Location Of Data Files – This is the location of the datafiles Myriad uses (in addition to the 
database). Check that this is set the same as your Myriad Playout system. 

4. Media File Locations – If you have set specific locations for media files in Myriad Playout, 
ensure they are set the same here! 
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5. The Options Tab – Takes you to some additional OCP options. 
6. Minimise To System Tray – When this option is ticked, if you minimise OCP it will minimise to 

a small icon in your PC system tray. 
 

 
 

The Help Menu 
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• Feedback Settings – Allows you to toggle whether to send anonymous usage data to 
Broadcast Radio. 

• Version History – View a text record of changes and updates to the application. 

• Broadcast Radio Website – Opens the Broadcast Radio website. 

• Check For Updates – Check for an updated version of the software. 

• About – View the version number for your software.
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Additional OCP 5 PRO Features 
 

OCP 5 PRO offers a number of advantages over the standard OCP 5 that is often provided 
free of charge to Myriad users. The key advantages are outlined below. 
 

• Multiple Services – OCP 5 PRO allows you to configure a number of Services meaning 
you can use a single copy of OCP 5 PRO to provide additional information for several 
radio stations. Services in OCP 5 PRO are licensed on a per service basis so you only pay 
for what you need. 

 

• Multiple Outputs Of The Same Type – In OCP 5, you can only have one of each type 
of Output configured at any one time. This means that while you can update several 
pages on a web site at the same time. You cannot update pages on completely 
different web servers. OCP 5 PRO removes this restriction. 

 

• More Items – OCP 5 PRO allows you to display information about the previous and 
next 50 Items in your station’s “Log” allowing you a far greater flexibility in the 
information you pass on to the listener. 

• Compatibility With 3rd Party Playout Systems – OCP 5 only works with Myriad but 

OCP 5 PRO can get the Item information from a file outputted by a 3rd party playout 

system giving the advantages of OCP 5 to all stations regardless of what playout 
system they use. 


